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1. Acknowledgements

The firmware used for this project was developed by Paul Rickards in 201 and has been
released under the GPLv3 license. The firmware was based on the original code by Jussi
Salin in 2015 and released under the GPLv3 license.

This project is not to compete with Paul’s retail release WiFi232 modem which is
superior to this project as it offers other options this does not. This project is simply to
show how | got it all working within his code and for any DIY’ers out there that would
like to try.

Many thanks go out to Paul for being very responsive and answering my many
questions to understand how this thing worked.

Paul Rickards code that will be used for this project is located at:

https://github.com/RolandJuno/esp8266 modem

Jussi Salin’s original code is located at:

https://github.com/jsalin/esp8266 _modem

2. Project Information

This project will take a HUZZAH ESP8266 WiFi microcontroller and pair it with a RS232
to TTL converter board along with a USB breakout board for powering the unit. A LED,
power switch and 2 x momentary switches will be added for added functionality.

The HUZZAH EPS8266 is a Wi-Fi enabled microcontroller that can add Internet to your
next project. Itis an 80 MHz microcontroller with a full Wi-Fi front-end (both as client
and access point) and TCP/IP stack with DNS support as well. While this chip has been
very popular, it has also been very difficult to use.

| have been successful getting the device coded with Paul Rickards firmware that is very
familiar to many of us. These commands are based on or a very familiar Hayes AT
command set. (See Acknowledgements section).
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3. Requirements

3.1 Skill Requirements

e Some basic solder skills
e Basic electronic understanding
e Patience

3.2 Hardware Requirements

e FTDI Cable to update the firmware
https://www.amazon.com/gp/product/BO0QT7LQ88/ref=oh aui detailpage 006 s00?i

e=UTF8&psc=1

Note: | have found a couple of cables and or FTDI boards that will not code the ESP8266
for some reason or another and | always get an Error 1 when trying to code. But this
little $6.00 FTDI cable has never failed me.

e HUZZAH ESP8266 Breakout Board
https://www.amazon.com/gp/product/BO1MDSUKHE/ref=o0h aui detailpage 009 s00
?ie=UTF8&psc=1

e RS232 to TTL Converter with Male DB9 (3.3v to 5v)
https://www.amazon.com/gp/product/BO0OPU2QJ4/ref=oh aui detailpage 004 s00?i
e=UTF8&psc=1

e USB Type A Female Breakout board ( | use this to power the ESP8266)
https://www.amazon.com/Female-Breakout-Board-2-54mm-
Header/dp/B01K42V2S2/ref=sr 1 8?s=electronics&ie=UTF8&qid=1492840310&sr=1-
8&keywords=usb+breakout

e Decent pencil type soldering iron and

e Thin Sn63/Pb37 solder

e 1 x DSUB 9 Female

e 1 x DSUB25 Male

e 8 Conductor wire

e USB Cable for power

e Project box to putitall in

e 2.54mm Male headers (I used a total of 18)
e 10 x Female to Female jumper wires
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2 x Momentary push button switches (normally open)
1 x SPST micro rocker switch

e 1 x 5mm Blue LED and Bezel to fit

1 x 120 Ohm Resistor ¥ watt

3.3 Software Requirements

e Arduino IDE 1.8.0 or higher installed
https://www.arduino.cc/en/Main/Software

e ESP8266 Libraries for Arduino IDE
http://arduino.esp8266.com/stable/package esp8266com index.json

This is configured within Arduino IDE program for Additional Boards
Manager URL’s under File - Preferences

4. The Code

4.1 Download the Code

The below links is to the firmware | used that has various AT commands coded in order
to act like a Hayes modem. The code has an option to hold down GPIOO for at least 5
seconds and when released the device will boot into 300 baud. This is useful if for
some reason you cannot access it on a computer that does not operate at the
configured baudrate that is hard coded in the VRAM.

For example if you want to move it to a Ti-99/4A without the F18A and it was
previously used on a F18A enabled system that supported the higher baudrate and the
unit was hardcoded in NVRAM with a higher baudrate such as 9600 or above.

Firmware Code:

https://github.com/RolandJuno/esp8266 modem
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5. Enclosure & Component Preparation

5.1 Enclosure

If you have not decided the best enclosure to use then this is the time. | used a small
aluminum enclosure as it’s easy to work with. | have heard of aluminum enclosures
causing signal issues with the wireless antenna, but | have not had the issue. Of course
my unit sits about 3 feet from my wireless router too.

It is best at this point to decide how the best placement of each component within the
enclosure is.

o Create standoffs if needed

» | used some plastic screws/bolts with nuts. Cheap and easy.
o Cut appropriate holes required to mount components such as:

=  Momentary switches

= LED & Bezel

= Rocker power switch

= DB9 Serial to TTL adapter board

= USB connector

5.2 Components

It is best at this point to solder the header connectors to the boards.

After determining the best way to mount the components you will now know the best
orientation for the header connectors, whether it will be straight or right angled
headers on top or bottom based on the enclosure chosen and how your components
will fit within it.

The headers | soldered were as annotated below:
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HUZZAH ESP8266:

Headers:

Top: RX, TX, #0, 3V,
GND

Side: GND, V+, RX, TX
Bottom: GND, V+ RST
Note: Side connections

are for programming
with FTDI cable.

RS232 to TTL Converter:

Headers:
GND, RX, TX, VCC

Picture is for reference only. There are
a ton of manufactures of this type of
unit and yours may not look exactly like
this. Just match up the pins to what

you purchase.
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USB Type A Female Breakout Board:

Headers:

GND, VBUS/VCC

Only used for powering the unit.

VBUS & VCC are just voltage in.
Depending on the board purchased
it will have one of the two labels.

Picture is for reference only. There
are a ton of manufactures of this
type of unit and yours may not look
exactly like this. But the pinout
should be the same.

6. Modifying the Code

There is one command that | found that is remarked out but works and if you want it to
display within the help and current/stored settings areas it’s easy to accomplish. This
command is setting the listen port of your device. Default is 6400, | changed mine to
9900. Leaving it at 6400 is just fine. This update is only if you want to see it displayed on
the help and settings screens.

If you want to see the extra command when issuing the AT? Command then find the code
areas that are commented out with ‘//’ and remove the ‘//’ before the code.

Search for:
//Serial.print(“Server TCP PORT: “)

Should be two entries you find. One under each of the below code headings:

void displayCurrentSettings()



http://shift838.99er.net/

HUZZAH ESP8266 Chris Schneider
WiFi Internet Modem http://shift838.99er.net

void displayStoredSettings()
Now search for:
//Serial.printIn("SERVER PORT...:

Should be under the below display heading

void displayHelp()

The above code snippets is just the beginning of the line of code. Just remove the ‘//’ from
the beginning of the lines and save.

7. Connecting the FTDI programming cable

To hook up the FTDI cable to your PC is simple, just plug it in. Verify on your computer
which serial port has been assigned to the FTDI. You will need to hook it up to the
HUZZAH ESP8266 to program upload the firmware to the device. My FTDI cable is
referenced below but be sure to verify what connectors go where for your FTDI / Console
cable.

I also recommend if using one of these since the wires can be frail to use 4 male to female
header extension cables on the ends.

My FTDI cable was coded as below, but please verify yours is correct.

Color Pin
Black Ground
Red V+
Green RX
White TX
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8. Setting up Software for Use with HUZZAH ESP8266 WiFi Board

Download and setup the Arduino software referenced in ‘Software Requirements’
section.

e Install the Arduino software and take all defaults.

e Launch the Arduino software

e Click on File > Preferences

Ensure that the new location for the ESP8266 board URL is configured as below:

Should be set to:

http://arduino.esp8266.com/stable/package_esp8266com_index.json
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Preferences >
Settings  Network
Sketchbook location:
|C:‘,Users‘l,Chris\DommentsWduind | | Browse
Editor language: |System Default e | (requires restart of Arduino)
Editor font size:
Interface scale: Automatic % ({requires restart of Arduina)

Show verbose output during: [_] compilation [ upload
Compiler warnings: MNone -«

[] Display line numbers

[[] Enable Code Folding

Verify code after upload

[] Use external editar

Check for updates on startup

Update sketch files to new extension on save (.pde -> .ina)
Sawe when verifying or uploading

Maore preferences can be edited directly in the file

C:\sers\Chris\AppDataLocal Wrduino 15\preferences. txt
{edit only when Arduine is not running)

Lok |
e Click OK

Verify the ESP8266 board is installed and up to date within the Board Manager area.

To Install/Update the Board Manager go to Tools - Board: “....” (May have text
between the quotes) - Boards Manager
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| @'esp_modem|nrduino 8.1
File Edit Sketch Tools

Auto Format
Archive Sketch
Fix Encoding & Reload

esp_modem

Serial Monitor

Serial Plotter
WiFi101 Firmware Updater

Board: "Adafruit HUZZAH ESP2266"
Flash Size: "4M (3M SPIFFS)"

CPU Frequency: "80 MHz"

Upload Speed: "115200"

Port

Get Board Info

Programmer: "AVRISP mkll"

Burn Bootloader

Ctrl+T

Ctrl+Shift+ M
Ctrl+Shift+L

Boards Manager...

Teensyduino
Teensy 3.6
Teensy 3.5
Teensy 3.2/ 3.1
Teensy 3.0
Teensy LC
Teensy++ 2.0

implied war Teensy 2.0

When the board manager comes up it will take a few seconds to find all the different
boards that are loaded within the system. From there you can search for ‘esp8266’

(without quotes).

@ Boards Manager

Type All « | |esp3266

esp8266 by ESP8266 Community version 2.2.0 INSTALLED
Boards included in this package:

Online help
More info

Select version w Install

Generic ESP8266 Module, Olimex MOD-WIFI-ESPE266(-DEV), NodeMCU 0.5 (ESP-12 Module), NodeMCU 1.0 (ESP-12E Module),
Adafruit HUZZAH ESP8266 (ESP-12), ESPresso Lite 1.0, ESPresso Lite 2.0, SparkFun Thing, SweetPea ESP-210, WeMos D1, WeMos
D1 mini, ESPino (ESP-12 Module), ESPino (WROOM-02 Maodule), Wiflnfo, ESPDuino.

Remove

If it is not installed or needs updated

Close

the ‘Install’ button will be enabled.

e Click ‘Install’ to install/update the ESP8266 board modules.
e Click the ‘Tools’ menu and ensure the settings match as below:
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€9 esp_modem | Arduino 1.8.1 — O >

File Edit Sketch Tools Help

Auto Format Ctrl+T E
Archive Sketch
esp_modem Fix Encoding & Reload n
| Serial Monitor Chrl+ Shift+M 2
Serial Plotter Ctrl+5Shift+L

WiFi101 Firrnware Updater

Board: "Adafruit HUZZAH ESP2266" »
Flash Size: "4M (3M SPIFFS)" »
CPU Frequency: "80 MHz" >
Upload Speed: "115200" b
Port >

Get Board Info

Prograrmnmer: "AVRISP mkll" >

Burn Bootloader

Updates available for some of your boards and libraries | %

Ensure you select the correct Port that your FTDI was detected on your PC
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@ esp_modern | Ardui
File Edit Sketch Tools

no 1.8.1

Help

a

>

esp_modem

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

WiFi101 Firmware Updater

Board: "Adafruit HUZZAH ESP2266"

Flash Size: "4M (3M SPIFFS)"
CPU Frequency: "80 MHz"
Upload Speed: "115200"
Port

Get Board Info

Programmer: "AVEISP mkdl"

Burn Bootloader

Ctrl+T

Ctrl+Shift+M A
Ctrl+ShiftsL |~ -~ CF°

Serial ports
COmM1

9. Programming HUZZAH ESP8266 WiFi Board

To program the HUZZAH ESP8266 you must use the FTDI cable (at least that’s how | did

it).

If the FTDI cable has not been connected Reference the ‘Connecting the FTD/
Programming Cable’ section to connect the FTDI cable to HUZZAH ESP8266 module.

e Verify what serial port has been assigned to the FTDI cable

e Launch the Arduino IDE software (if not already launched)

e Load the ESP8266 modem sketch downloaded from ‘The Code’ section by selecting

File > Open

e Navigate to the saved location of the Arduino sketch and open
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o The first time it opens the program will alert you it must be copied to a
folder. Just click OK and it will do it for you. Usually located under My
Documents\Arduino folder

e Verify board settings as outlined in ‘Setting up Software for Use with HUZZAH
ESP8266 WiFi Board’ section.

Within your Arduino program there will be a quick launch bar of buttons:

@' esp_modem | Arduine 1.8.1 B - =

File Edit Sketch Tools Help

gsp_modem

e Click the . shown below to verify/compile the code to ensure there is no errors.

Within the status screen it should look like something similar as below:

Adafruit HUZZAH ES

If there are any errors it will be reported in this window.

Once the compile is verified you can now program the board.

In order to program the ESP8266 you will now need to initiate the board into
programming mode.

To initiate the HUZZAH ESP8266 into programming mode you will need to:

1. Hold down the GPIOO button, the red LED will be lit
2. While holding down GPIOO, click the RESET button
3. Release RESET, then release GPIOO
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4. When you release the RESET button, the red LED will be lit dimly, this means its
ready to program

e Click the . on the quick launch Arduino bar to start the programming of the
board.

Once clicked it will recompile and program. The status windows should look similar to
the below.

Genernc oard on COMSS

It will take a couple of minutes or so to upload the program. If there are any errors it will
be reported in this window.
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10. Wiring Diagrams

10.1 TI-WiFi Component / Cable Wiring

Tie all grounds together for all components including momentary switches, LED. By
doing this you will only need to really wire to one ground on the HUZZAH ESP8266
board. On my final device the final wiring was only 2 grounds, leaving the ground for
the programming side of the ESP8266 was left open so that if needed it’s easily
updated without unhooking any internal wires.

Schematic:

DB9 Male USE TYPE A FEMALE i SPST

Serial-to-TTL BEREAKOUT BOARD LED OFF jON

vec GND GND D+ D- VBUS

?gg ®eee

A

= 120 Chm
="

@

@
®

EN 16 14 12 13 V+ VBat GHD

A A &)

(C)opyright 2017 - Chris Schneider
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Connect to GPI0 Tie all grounds together
Momentary Button for all components,
switches LED, etc.

Supplying power via USB

=,

Jes s

L

Connect to Reset
Momentary Button

10.2 Cable Wiring Pinout

DSUB 9 Female PIN # DSUB 25 Male PIN #
3 2
2 3
7 4
8 5
6 6
5 7
1 8
4 20

A Standard null modem cable will work if the unit will be hooked up to a standard PC serial
port or NanoPEB.
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11. Powering up the Unit

11.1 Connect Cables

Connect the required cables for power and serial communications.

11.2 First Time Boot

My experience is it’s real easy to setup from a PC then move it to your retro computer.

The first time the unit is powered up after programming you will need to set your
terminal to 300 baud. Power the unit up after the terminal program has been launched.
Usually a garbage character(s) may appear. | typically after programming the unit and
powering it up if there is no response when trying to type a command | will hold the
GPIOO0 down for at least 5 seconds and release then it will boot up. | have seen on
occasion that you will have to press enter before it starts to boot up and you see the
initial text display that includes firmware version, etc.

Once in then go ahead and set your baud rate (see Command Reference Section). As
soon as the baudrate change command is issued the device will change the baud rate.
The terminal will now need to be set to the new baud rate before you can save it.

Once back into the device with the new baudrate issue the AT&W command to write it
to the NVRAM settings. This is now your permanent baudrate when the unit is powered

up.

11.3 Ready to Go!

Now that you have the baud rate set and are ready. The below command should get

you going:
ATS$SSID=PUT IN YOUR WIRELESS SSID HERE <PRESS ENTER>
AT$PASS=PUT IN YOUR WIRELESS PASSWORD HERE <PRESS ENTER>

ATC1 <PRESS ENTER>
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Now you should see the modem attempt to connect to the wireless. If it connects you
will see:

Note: Your SSID/Network Name and IP’s will be different.

CONNECTING TO SSID SKYNET.......

CONNECTED TO SKYNET

IP ADDRESS: 192.168.1.189

OK

If it fails to connect just issue the ATC1 command again.
To see all of your network information once it has connected:
ATl (notalLora 1 butanuppercasei)

You should see the below screen but with all your network information:

WIFI STATUS: CONNECTED
SSID.......: YOURSSID

MAC ADDRESS: MAC ADDRESS HERE
IP ADDRESS.: IPADDRESS
GATEWAY....: GATEWAY IP

SUBNET MASK: NETMASK

SERVER PORT: 6400

WEB CONFIG.: HTTP://IPADDRESS
CALL STATUS: NOT CONNECTED

Now let’s save the configuration so you don’t have to do this again!
AT&W <Press Enter>

Now try to call out:

ATDT FUSIONBBS.DDNS.NET:9640
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12. Command Set Summary

12.1 Help

An online help screen that shows the command set can be listed within the terminal by typing either
of the below two commands:

| AT? | ATHELP

12.2 Auto Answer

Enable/Disable Auto Answer incoming connection request. Issue the below command:

ATSO=N N =
0 Disabled
1 Enabled

12.3 Command Mode

To enter command mode after a connection has been established to a remote computer
enter the below command within 1 second:

e

12.4 Dial Host

To dial a host from the device once connected to the WiFi network simply initiating:

ATDTHOST:PORT#

12.5 Echo

Enable/disable local echo (Duplex) by issuing the below command:

N
0 | Disabled
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ATEN | 1 |Enabled |

12.6 Exit Command Mode

To exit command mode enter the below command:

ATO

12.7 Factory Defaults

To restore the device back to factory defaults issue the below command:

AT&F

12.8 Flow Control

Flow control can be enabled and disabled with the below command:

AT&KN (Where N=0 for None; N=1 for Hardware; N=2 for Software)

N =

0 None
Hardware

2 Software

12.9 Hangup/Disconnect

To disconnect from a connected session enter the below command (must be in
command mode):

ATH

12.10 HTTP GET

Fetch URL from internet. Will close connection once page is finished fetching.

ATGET<URL>
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12.11 Load NVRAM

If changes were made and you want to reset them and have not saved current settings
to NVRAM the below command can be used to reset back to the powered on default of
the NVRAM.

ATZ

12.12 Network Info

Displays current network information such as IP address, WIFI Status, Gateway, Subnet
Mask, etc. Issue below command:

ATI

12.13 PETSCII

Enable/disable PETSCII graphics. Terminal must support PETSCII if enabled. Issue
below command to enable or disable:

ATPETN N =

0 Disabled
1 Enabled

12.14  Pin Polarity

To change the pin polarity issue the below command:

AT&PN (Where N=0/Inverse, 1/Normal) - Typically it’s set to Normal and used by
Commodore 64 computers only.
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12.15  Query Commands

To query most command values above simply enter the command with a ? at the end.
Do not enter the N value with the ? command. For example to retrieve the current baud
rate enter:

ATS$SB?

12.16 Save to NVRAM

To save settings to NVRAM so that the settings stay resident when powered off and will
be loaded upon next power up issue the below command:

AT&W

12.17 Set Baud Rate

To set the baud rate the WiFi Modem will use enter the below command:

AT$SB=N N for Baud Rates
300 4800 38400
1200 9600 57600
2400 19200 115200

Note that currently the TI-99/4A and Myarc Geneve 9640 computers with TIMXT or Port
(for Geneve) can max out at 38400 bps.

For Ti-99/4A’s to use higher than 4800bps accurately the F18A must be installed in
order to use the TIMXT terminal program.

12.18  Set Busy Message

To set a busy message to be displayed when a connection attempt is made (Auto
Answer must be enabled to work) issue the below command:

AT$BM=YOUR BUSY MESSAGE HERE



http://shift838.99er.net/

HUZZAH ESP8266 Chris Schneider
WiFi Internet Modem http://shift838.99er.net

12.19  Set Speed Dial Entries

To set a host in order to use the speed dial command enter the below command:
AT&ZN=HOSTNAME:PORT (Where N=0 to 9)

Once created you will want to save it to NVRAM with the AT&W command.

12.20  Set Server Listening Port

The WiFi Modem firmware has the ability to answer incoming connection request on a
specific port. By default the port is coded to 6400, but this can be changed. Issue the
below command to change the port. To ensure the port is stored when the unit gets
powered off the AT&W command will also have to be issued to save it.

ATS$SP=N (Where N = 1 to 65535)

12.21 Set WiFi Password

Before connecting to a WiFi network a WiFi Password must be set. To set the WiFi
Password enter the below command:

ATS$PASS=YOUR WIFIPASSWORD HERE

12.22  Set WIFi SSID

Before connecting to a WiFi network a WiFi SSID must be set. To set the SSID (network
name given to the WiFi) enter the below command:

AT$SSID=YOUR WIFISSID HERE

12.23  Show Settings

To show current active settings and NVRAM settings issue the below command:

AT&V
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12.24  Speed Dialing Stored Entries

Speed dialing host can be done if the host is stored into the NVRAM settings. Host are
stored in slots 0-9. To speed dial simply initiate the below command:

ATDSN (Where N=0 to 9)

12.25  Telnet Command Handling

Enables/disables telnet command handling. Typically set to disabled.

ATNETN N =

0 Disabled
1 Enabled

12.26  Verbose Mode

To enable/disable verbose response codes enter the below command:

ATVN N =

0 Disabled
1 Enabled

12.27  WIFi (Connect/Disconnect)

To connect or disconnect to and from the WiFi network after the WiFi SSID and WiFi
Password have been set issue the below command:

ATCN N =

0 Disconnect From WiFi
1 Connect To WiFi
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13. TI/Geneve BBS (via Telnet)

The below BBS’ can be connected to over the internet with this device or any other

telnet based device/pc.

BBS Name Address Port
FuSiON BBS fusionbbs.ddns.net 9640
Heatwave heatwave.ddns.net 9640
The Keep www.thekeep.net 23
14. Support

If anyone needs help with this project feel free to reach out to me and I will do the best

that | can.

Shift838@att.net

http://shift838.99er.net
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